Training Document for Comprehensive Automation Solutions

 Totally Integrated Automation (T I A)

**MODUL E04**

**PROFINET**

with

**IO Controller CPU 315F-2 PN/DP**

and

**IO Device ET 200S**
This document has been written by Siemens AG for training purposes for the project entitled “Siemens Automation Cooperates with Education (SCE)”. Siemens AG accepts no responsibility for the correctness of the contents.

Transmission, use or reproduction of this document is only permitted within public training and educational facilities. Exceptions require the prior written approval by Siemens AG (Michael Knust michael.knust@siemens.com).

Offenders will be liable for damages. All rights, including the right to translate the document, are reserved, particularly if a patent is granted or utility model is registered.

We would like to thank the following: Michael Dziallas Engineering, the teachers at vocational schools, and all others who helped to prepare this document.
The following symbols are used as a guide through Module E04:

- **Information**
- **Programming**
- **Sample Exercise**
- **Notes**
1. PREFACE

In terms of its contents, Module E04 is part of the teaching unit entitled 'IT Communication with SIMATIC S7'.

Learning Objective:

In Module E04, the reader learns how the PROFINET -with the CPU 315F-2PN/DP as IO controller and the ET 200S as IO device- is started up. Module E04 illustrates the method in principle, using a short example.

Prerequisites:

To successfully work through Module E04, the following knowledge is assumed:

- Knowledge in handling Windows
- Fundamentals of PLC programming with STEP 7 (for example, Module A3 - 'Startup' PLC Programming with STEP 7)
- Fundamentals of network engineering (for example, Appendix V - Basics of Network Engineering)
Hardware and software required

1. PC, operating system Windows 2000 Professional starting with SP4/XP Professional starting with SP1/Server 2003 with 600MHz and 512RAM, free hard disk storage 650 to 900 MB, MS Internet Explorer 6.0 and network card

2. Software STEP7 V 5.4

3. PLC SIMATIC S7-300 with the CPU 315F-2 PN/DP
   Sample configuration:
   - Power supply: PS 307 2A
   - CPU: CPU 315F-2 PN/DP

4. Distributed periphery ET 200S for PROFINET with 2 digital inputs and 4 digital outputs
   Sample Configuration:
   - Interface Module IM151-3 PN HIGH FEATURE
   - Power module PM-E DC 24V ...48V/AC 24V...230V
   - Electronic module: 2DI Standard DC 24V
   - Electronic module: 4DO Standard DC 24V/0.5A

5. Ethernet connection between PC, CPU 315F-2 PN/DP and ET200S with IM 151-3 PN
2. NOTES ON USING THE CPU 315F-2 PN/DP

The CPU 315F-2 PN/DP is a CPU that is shipped with two integrated interfaces.
- The first interface is a combined MPI/PROFIBUS-DP interface that can be used on the PROFIBUS DP as master or slave for connecting distributed periphery/field devices with very fast response timing.
  In addition, the CPU can be programmed here by means of MPI or also PROFIBUS DP
- The second interface is an integrated PROFINET interface.
  It allows for using the CPU as a PROFINET IO controller for operating distributed periphery on PROFINET. The CPU can also be programmed using this interface!
- Fault-tolerant periphery devices can also be used on both interfaces.

Notes:
- In Module E04, the CPU 315F-2 PN/DP is used on the PROFINET as IO controller.
- To run this CPU, a Micro Memory Card is required!
- The addresses for input and output modules can be parameterized at this CPU.
3. NOTES ON USING THE ET200S WITH THE IM 151-3 PN HF

The SIMATIC ET 200S is a decentral IO device configured in a highly modular mode. It can be operated with different interface modules:

- **IM 151-1 BASIC, IM 151-1 STANDARD** and **IM 151-1 FO STANDARD** for connecting a maximum of 63 IO modules (all types except PROFIsafe) to the PROFIBUS DP; alternatively, bus connection with RS 485 Sub-D connector or by means of an integrated fiber-optic connection

- **IM 151-1 HIGH FEATURE** for connecting a maximum of 63 IO modules (all types, including clocked mode for PROFIsafe) to PROFIBUS DP; bus connection with RS485 Sub-D connector

- **IM 151-3 PN** for connecting a maximum of 63 IO modules (all types, including the clocked mode for PROFIsafe) to PROFINET IO controllers; bus connection by means of RJ45 connector

- **IM 153 PN HF (HIGH FEATURE)** for connecting a maximum of 63 IO modules (all types; including the clocked mode for PROFIsafe) to PROFINET IO controllers; bus connection with 2 x RJ45 connector

- **IM 151-7/F-CPU, IM 151-7/CPU** or **IM 151-7/CPU FO** for connecting a maximum of 63 IO modules (all types; PROFIsafe only with IM151-7/F CPU) to PROFIBUS DP; alternatively bus connection with RS 485 Sub-D connector or by means of an integrated fiber-optic connection; with integrated CPU 314 of the SIMATIC S7-300, for preprocessing process data.

The following IO modules can be used:

- **Power modules** for individual grouping of load and encoder supply voltages and their monitoring
- **Digital electronic modules** for connecting digital sensors and actuators
- **Analog electronic modules** for connecting analog sensors and actuators
- **Sensor module** for connecting IQ sense sensors
- **Technology modules** Electronic modules with integrated technological functions, such as counting, positioning, data exchange, etc.
- **Frequency converters and motor starter modules**

For training purposes, an integrated system is provided, suitable for teaching many technologies

**Notes:**
- In Module E04, the interface module IM151-3 PN HF is used as PROFINET IO device.
- A micro memory card is required for running the IM151-3 PN HF!
4. STARTING UP THE PROFINET (IO CONTROLLER CPU 315F-2 PN/DP/IO DEVICE ET200S)

Below, the startup of a PROFINET network with the CPU 315F-2 PN/DP as IO controller and the ET200S as IO device is described.

To test the configuration, a program is written. In this program, an indicator lamp P1 is activated when two buttons, S0 and S1, are operated simultaneously.

Assignment List:

| I0.0 | S0  | Button Selection 1 |
| I0.1 | S1  | Button Selection 2 |
| O0.0 | P1  | Indicator lamp     |

1. The central tool in STEP 7 is the 'SIMATIC Manager'. Here, it is called with a double click. (→ SIMATIC Manager)

2. STEP7 programs are managed in projects. We are now setting up such a project. (→ File → New)
3. Now, the project is assigned the 'Name' 'ET200S_PN' (→ ET200S_PN → OK)

4. Highlight your project and insert an 'Industrial Ethernet Subnet'. (→ ET200S_PN → Insert → Subnet → Industrial Ethernet)
5. Then a 'SIMATIC 300 Station' is inserted. (→ Insert → Station → SIMATIC 300 Station)

6. With a double click, open the configuration tool 'Hardware'. (→ Hardware)
7. Open the hardware catalog by clicking on the symbol 'Catalog'.

There, arranged in the following directories:
PROFIBUS DP, PROFIBUS PA, PROFINET IO, SIMATIC 300, SIMATIC 400,
SIMATIC PC Based Control, and SIMATIC PC Station,
all racks, modules and interface modules are provided for configuring your hardware.
Insert 'Rail' with a double click. (SIMATIC 300 → RACK-300 → Rail)

After that, a configuration table is displayed automatically for configuring Rack 0.
8. From the hardware catalog, you can now select all modules that are also in your real rack, and insert them in the configuration table.
To this end, click on the name of the respective module, hold the mouse key and drag the module to a line in the configuration table.
We are starting with the power unit ‘PS 307 2A’. (→ SIMATIC 300 → PS-300 → PS 307 2A)

Note: If your hardware differs from the one displayed here, simply select the corresponding modules from the catalog and insert them in your rack. The order numbers of the individual modules -that are also indicated on the components- are displayed in the footer of the catalog.
9. Next, we are dragging the 'CPU 315F-2 PN/DP' to the second slot. The order number and the version of the CPU can be read off the front of the CPU. (SIMATIC 300 → CPU-300 → CPU 315F-2 PN/DP → 6ES7 315-2FH10-0AB0 → V2.3)

10. When entering the CPU, the following window appears. In it, assign an 'IP Address' to the CPU 315F-2 PN/DP, specify the 'Subnet screen form' and select the 'Ethernet' network that has already been generated. Optional: for net-overreaching communication, a 'Router Address' can be selected. Confirm your inputs with 'OK' (IP Address: 192.168.1.10 → Subnet form screen: 255.255.255.0 → Ethernet(1) → Use Router → Address: 192.168.1.1 → OK)
Notes on networking on the Ethernet (additional information in Appendix V of the Training Document):

MAC Address:
The MAC address consists of 2 parts: a fixed and a variable part. The fixed part ("Basic MAC address") indicates the manufacturer (Siemens, 3COM, ...). The variable part of the MAC address differentiates the various Ethernet stations, and should be assigned unique world-wide. On each module, a MAC address assigned by the factory is imprinted.

Value range for the IO address:
The IP address consists of 4 decimal numbers from the value range 0 to 255. They are separated by a period; for example, 141.80.0.16

Value range of the subnet screen form:
This screen form is used for recognizing whether a station or its IP address is part of the local subnet, or whether it can only be accessed by means of a router. The subnet screen consists of 4 decimal numbers from the value range 0 to 255, separated by a period; for example: 255.255.0.0
In binary representation, the 4 decimal numbers of the subnet screen form have to contain, from the left, a series of gapless values "1" and from the right, a series of gapless values "0". The values "1" determine the area of the IP address for the network number. The values "0" determine the area of the IP address for the station address.
Example:
Correct values: 255.255.0.0 Decimal = 1111 1111.1111 1111.0000 0000 0000 0000 binary
255.255.128.0 Decimal = 1111 1111.1111 1111.1000 0000 0000 0000 binary
255.254.0.0 Decimal = 1111 1111.1111 1110.0000 0000 0000 0000 binary
Incorrect value: 255.255.1.0 Decimal = 1111 1111.1111 1111.0000 0001 0000 0000 binary

Value range for the address of the network transition (Router):
The address consists of 4 decimal numbers from the value range 0 to 255, separated by a period; for example, 141.80.0.1.

The relationship of IP addresses, router address and the subnet screen form:
The IP address and the address of the network transition may differ only at those positions where there is an "0" in the subnet screen form.
Example:
You entered: for subnet screen form 255.255.255.0; for IP address 141.30.0.5 and for the router address 141.30.128.1.
The IP address and the address of the network transition may have a different value only in the 4th decimal number. In the example, however, the 3rd position is already different.
In the example, you have to change alternatively:
- the subnet screen form to: 255.255.0.0 or
- the IP address to: 141.30.128.5 or
- the address of the network transition to: 141.30.0.1
11. After you have made the network settings, a bar appears on the right of the CPU315-2 PN/DP, the 'PROFINET IO System', where you can arrange PROFINET IO devices. This is done by clicking on the desired module (here 'ET 200S' with 'IM151-3PN HF') in the hardware catalog in the path 'PROFINET IO' and dragging it to the 'PROFINET IO System'. (→ PROFINET IO → I/O → ET 200S → IM151-3PN HF)
12. By double clicking on 'IM151-3 PNHF', its properties are opened. (→ IM151-3 PNHF)

13. Each IO device has to be assigned a 'Device name' that is unique within the PROFINET IO system and an IP address on the 'Ethernet'. (→ Device name: IM151-3PNHF → Ethernet)
14. After the 'IP Address' was assigned, it has to be accepted with 'OK'.

(→ IP Address: 192.168.1.11 → OK → OK)
15. From the hardware catalog, you can now select all additional modules that are inserted in your real ET200S and add them to your configuration table. To this end, click on the name of the respective module, hold the mouse key, and drag the module to a line in the configuration table. We are starting with the power module ‘PM-E DC24V...48V/AC24...230V’ by dragging it to Slot 1.  

(→ PROFINET IO → I/O → ET 200S → IM151-3 PN HF → PM → PM-E DC24V...48V/AC24...230V)
16. Next, we are dragging the digital input module '2DI DC24V ST' to the second slot. The order number and the version can be read from the module. (→ PROFINET IO → I/O → ET 200S → IM151-3 PN HF → DI → 2DI DC 24V ST)

17. Then, we drag the digital output module '4 DO DC 24V/0.5A ST' to the 3rd slot. The order number and the version can be read from the module. (→ PROFINET IO → I/O → ET 200S → IM151-3 PN HF → DO → 4 DO DC 24V/0.5A ST)
18. Now, the addresses of the inputs and outputs in the ET 200S can be changed. This is done by double clicking on the corresponding input or output submodules in the ET 200S and setting them under the tab ‘Addresses’. These addresses should be noted down for each case. Addresses are assigned automatically in the sequence in which the submodules are entered. (→ 4DO DC 24V/0.5A ST → Addresses → OK)

19. By clicking on , the configuration table is saved and compiled (→ )
20. Now, highlight the IO device and assign it a name 'Assign device name'. (→ IM151-3PNHF → PLC → Ethernet → Assign device name)

**Note:** A precondition for this is that the PG/PC interface is set to TCP/IP, and the network card of the PC is correctly configured. For example: IP address 192.168.1.99, Subnet 255.255.255.0 and router address 192.168.1.1. (refer to Module E02).

**Note:** Make sure your programming device is connected to the ET200S via the Ethernet.
21. We now select the ET200S to assign the name 'Assign name'. (→ ET200S → Assign name)

Note: If several IO devices are on the network, the device can be identified using the imprinted MAC address.

22. The new device name is then displayed in the area 'Available devices'. 'Close' the dialog. (→ Close)
23. Clicking on ![image](image.png) loads the configuration table to the PLC. The operating mode switch on the CPU should be on Stop! (→)

![image](image.png)

**Note:** Make sure your programming device is connected to the CPU via the Ethernet.
24. The CPU 315F-2 PN/DP is confirmed a destination module of the loading process. (→ OK)

25. In the dialog below, you can have the connected devices in the network 'Display'(ed). (→ Display)
26. Then, the CPU’s MAC address in the Ethernet is selected. If you are connected to only one CPU, accept with 'OK'. (→ OK)

Note: If several IO controllers are on the network, the device can be identified with the imprinted MAC address.

27. Now, the correct IP address has to be assigned to the IO controller if it has not been set correctly yet. Confirm the following dialog with 'Yes'. (→ Yes)

<<The selected station does not have an IP address. Do you want to assign the address 192.168.1.10 now?>>
28. After you loaded the hardware configuration, you can start creating the program. From the 'SIMATIC Manager', select the block 'OB1' with a double click. ($\rightarrow$ OB1)

29. Select the 'Programming language FBD' and accept with 'OK'. ($\rightarrow$ FBD $\rightarrow$ OK)
30. With ‘LAD, STL, FBD – Program S7 blocks’, you now have an editor with which you can generate your STEP7 program accordingly. To this end, OB1 has already been opened with the first network. To generate your initial operations, highlight the first network. Now you can write your first STEP7 program. In STEP7, individual programs are usually arranged in networks. A new network is opened by clicking on the network symbol ‘Network’. The STEP7 program that is to be tested can now be loaded.

In our case, this is only OB1. Save OB1 and click on Load. The CPU’s key switch should be on STOP! (→ STOP → RUN).

31. By setting the operating mode switch to RUN, the program is started. By clicking on the symbol for monitoring, the program can be monitored in ‘OB1’.

Note: Make sure the CPU is connected to the ET200S via the Ethernet.